Operatia de formatare in editorul de texte Word

Fisa de aplicatii

A. Formatarea la nivel de document

1. Deschideti documentul Word salvat pe Desktop cu numele Text.

2. Realizati in acest document urmatoarele setdri de pagina: format A4,
marginea de sus 2.32 cm, Jjos 2.11 cm, stdnga 2.32 cm, dreapta 1.53
cm, antet 1.34 cm, subsol 1.57 cm, orientare pagina verticala.

3. Aplicati urmdtoarele elemente documentului:

» antet cu textul: “Fisd de lucru” aliniat la stanga;

» subsol : data si ora;

» numerotare pagind: sus 1in dreapta folosind cifre
romane

B. Formatarea la nivel de caracter

Realizati urmatoarele formatari ale caracterelor pentru textul din document:

a) pentru titlu : font Verdana, dimensiune font 16, bold-italic, culoare font

albastru, culoare fond rosu, mod de spatiere expandat la 4 puncte, pozitia
textului pe linie mai sus cu 5 puncte;

b) pentru text : font Courier New, dimensiune font 12, bold, culoare font verde,

culoare fond galben, mod de spatiere condensat 0.5 puncte, pozitia textului pe
linie mai jos cu 3 puncte;

C. Formatarea la nivel de paragraf

1. Realizati urmitoarele formatari ale paragrafelor din text:
a) primul paragraf. aliniat stanga-dreapta, indentat la stanga cu 1.5 cm, prima linie indentata cu

b)

2. Salvati noul documentul cu numele Formatare intr-un folder numit de voi Exercigii de pe

Desktop.

0.7 cm, valoarea spatiului suplimentar dupa ultima linie a paragrafului 18 puncte, spatiul

dintre linii 1a 1.5 randuri;

al doilea paragraf. aliniat la stanga, indentat la stanga cu 1.2 cm si dreapta cu 1.3 cm, prima
linie indentata cu 0.5 cm, valoarea spatiului suplimentar inaintea primei linii 10 puncte si

dupa ultima linie a paragrafului 20 puncte, spatiul dintre linii la 3 randuri;

al treilea paragraf: aliniat la dreapta, indentat la dreapta cu 1.8 cm, prima linie indentatd cu
1 cm, valoarea spatiului suplimentar dupd ultima linie a paragrafului 16 puncte, spatiul

dintre linii la doui randuri.
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Editati urmatoarele formule:

I. Indice
a.X1=Xo>=a
b.X1+X2=X3+X4



C.2X1-2X2=4X3-3X4
d.X1-2X2+3X3=3X4+2X5+4X5
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IX.Determinanti

Editati urmatoarele formule:
a. f(x)=x* 2x+5 XeR

b. f(x)= x+— x<0
C. f(x)=3x-;+ x, X<0

d. f(x)=xx—‘31,x<o
e. f(x)=xx-3¥x, x>0
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1. Creati

un nou document Word.
Stabiliti marginile paginii astfel:

- sus:2cm

- jos:2,6.cm

- stanga: 2,6 cm

- dreapta: 2,2 cm
Indicatie: Utilizati optiunea Initializare pagina a meniului File.
. Inserati doi tabulatori: - primul pentru alinierea la dreapta la 7 cm;



- al doilea pentru alinierea la stinga la 9 cm;
4. Scrieti in document urmatorul text (0 poezie).

lubirea

tat de purd mi-e inbirea (tat de sfantd mi-e inbirea

Jncat pe axipa-i de ceariJncat pe wgul ei de patimi
Eu pent tn zani albastre Din cenusa ce mi-a cere
Cand, in suflet, ea imi axa. JImi astexne un pat de laciimi.

Cerinte: - font pentru titlu Brodway, pentru text Script MT Bold;
- dimensiune 16 pentru titlu, 14 pentru text;
- alinierea: la stinga
- culoare font: titlu rosu, text verde
- culoare fond: galben pai ( Format ->Borduri si umbrire -> Umbrire...)
- chenar: Trei-D, culoare portocaliu, stilul il alegeti a.i. sa se potriveasca cu cel din
imagine.

5. Inserati un antet aliniat la stanga care sa contina textul: ,,Nistor Ioan Bud, Crini si Orhidee”.

Folosind fontul Italic, dimensiunea caracterelor de 12, culoare font rosu, fundal Bleu pastel .
La subsol introduceti aliniat la stdnga textul ,,Fisa de laborator”, iar in dreapta ziua curenta
(Vizualizare -> Antet si subsol).

6. Inserati numerele de pagina la subsol (jos) centrat, format de numar: -1- ( Inserare-

>Numere de pagina)

7. Copiati prima strofa si plasati-o mai jos, sub chenar (Manevra Copiere si apoi Lipire. Puteti
de exemplu sa copiati cu <CTRL>+<C> si sa lipiti cu <CTRL>+<<CTRL>+<V>). Dati-i
titlul Puritate, aliniati textul si titlul centrat, incadrati-0 Tntr-un chenar si formatati-o asa
cum va place!

8. Copiati a doua strofa si plasati-0 mai jos, sub prima. Dati-ii titlul Sfintenie, aliniati textul si

titlul centrat, incadrati-0 Tntr-un chenar si formatati-o asa cum va place!

Spor eaball!

FORMATAREA UNUI DOCUMENT

Conceptul de formatare se refera la schimbarile care se fac in aspectul

documentului.

Intr-un document se identificd urmétoarele entitati care pot fi supuse formatarii:
¢ Caracterul = cea mai mica entitate manevrabila intr-un text (font, stil, latime , inaltime).

¢ Cuvantul = sir de caractere despartit de restul textului prin spatiul si semne de
punctuatie.

¢ Linia de text = grup de caractere despartite de restul textului prin caracterul sfarsit de
linie.

¢ Fraza = sir de caractere delimitata de restul textului prin punct.

¢ Paragraful = grup de linii de text despartite de restul textului prin caracterul sfargit de
paragraf (se obtine prin apasarea tastei ENTER) (alinierea, spatiul dintre linii,
indentarea).



¢ Obiectul = o imagine, un tabel, un grafic ce poate fi inserat in text.

Pagina fizica = intreaga suprafata de hartie.

¢ Pagina utila = suprafata de hartie pe care se scrie textul documentului (dimensiunea
paginii fizice, margini, orientarea paginii, anteturi si subsoluri).

¢ Documentul = colectie de paragrafe si obiecte.

*
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Marginea superioara
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v <«—— Marginea subsolului

Marginea inferioara

Formatarea paginilor presupune urmatoarele operatii:

e Stabilirea dimensiunii paginii fizice (meniul Figier — optiunea Initializare pagina...-
eticheta Hartie — sectiunea Dimensiune hartie :A4)

e Stabilirea dimensiunii paginii utile (meniul Figier — optiunea Initializare pagina...-
eticheta Margini — Sectiunea Margini: sus, jos,stanga, dreapta )

e Stabilirea orientérii paginii (meniul Fisier — optiunea Initializare pagina...- eticheta
Margini-sectiunea Orientare: tip portret/tip vedere)

e Numerotarea paginilor (meniul Inserare — optiunea Numere de pagina...-)

e Crearea anteturilor si subsolurilor de pagina (meniul Vizualizare — Antet si Subsol)



e Crearea notelor de subsol si a notelor de sférgit (meniul Inserare — optiunea Referinta
— Nota de subsol)

Formatarea caracterelor

Caracterele sunt reprezentate de litere, numere, simboluri (&,*), semne de punctuatie si
spatii. Termenul de formatare al caracterelor se refera la atributele pe care le au caracterele
individuale dintr-un document.

in cadrul unui text, caracterele utilizate sunt bine definite de anumite marimi cum ar fi :
» tipul fontului (Arial, Times New Roman, Comis Sans, Verdana)
» culoarea fontului
= stilul (B-bold (aldin), I-Italic(cursiv), U-underline (subliniat))
» dimensiunea acestuia (12,14,16,18,...,72).

Pentru formatarea caracterelor unui text se folosesc doua metode:

e Cu ajutorul comenzii Font din meniul Format

Fonk Spatiere caractere | Efecte bext
Skil Fonk; Dimensiune:
n; -
Trebuchet M5
Tunga
Tw Cen MT Aldin Cursiy
T Cen MT Condensed hd i
Culoare fonts Stil subliniere:
Aukomat V| |{ni|:i una) v|
Efecte
[ ] Taiere text cu o linie [ umbrs [ ] Majuscule reduse
[ ] Tsiere text cu linie dubld [] schits [ ] Doar majuscule
[ ] Exponent [ in relief [] ascuns
[ Indice [] aravat
Examinare
Titnes Mew Eoman
Font TrueType. Acest Font wa [ utilizat at3t pentru irnprrmantd cdt si pentru ecean,

[ Ok ] [ Rewvocare

e Cu ajutorul barei de instrumente de formatare
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1 — stiluri si formatare

2 — font

3 — dimensiune

4 — ingrosat (aldin, bold)
5 —inclinat (cursiv, italic)
6 — subliniat (underline)
7 — editor de ecuatii

8 — aliniere la stanga

9 — aliniere la centru

10 — aliniere la dreapta
11 — aliniere stanga - dreapta
12 — interlinie

13 — numerotare

14 — marcatori

15 — micsorare indent
16 — marire indent

17 — exponent

18 —indice

19 — bordura exterioara
20 — evidentiere

21 — culoare font

VoL

4—

i
1]
il
«— [

Vi

8 910 11 12 13

4—

1415 16

17 18 19 20 21



Editorul de texte Word
Formatarea unui document Word

In functie de introducerea textului, in Word existd doud metode prin care se pot aplica
majoritatea comenzilor de formatare:
= Pentru a formata un text deja introdus, acesta se selecteaza si apoi se da comanda
de formatare.Orice comanda de formatare va afecta numai textul selectat!
= Pentru a formata un text ce urmeaza a fi introdus, se muta cursorul in locul in care
se doreste introducerea textului si apoi se da comanda de formatare.

Formatarea paragrafelor presupune urmatoarele operatii:
e Alinierea si indentarea textului (meniul Format — optiunea Paragraf ...)
e Dimensiunea spatiului dintre linii gi dintre paragrafe (meniul Format —
optiunea Paragraf ...)
e Pozitiile tabulatorilor (meniul Format — optiunea Tabulatori...). Tabulatorii sunt
folositi pentru orientarea pe verticala a textului.
e Chenarele si Umbrele (meniul Format — optiunea Borduri i umbrire...)

Fiecare paragraf este urmat de marcajul de paragraf care poate fi vizualizat prin
activarea butonului Show (Afisare)/Hide (Ascundere) de pe bara de instrumente standard.

Puteti copia formatarea unui caracter sau paragraf astfel :
e Selectati caracterul sau pozitionati cursorul in paragraful a carui formatare
vreti sa o copiati
e Copiati formatarea : Ctrl+Shift+C sau butonul Descriptor de formate de pe
bara de instrumente standard
e Aplicati formatarea unei zone de text : selectati textul si apasati Ctrl+Shift +V
sau glisati mouse-ul peste zona de text

Combinatii de taste Operatia
Ctrl+B stil ingrosat
Ctrl+l stil inclinat
Ctrl+U stil subiliniat
Ctrl+L aliniere la stanga
Ctri+E aliniere la centru
Ctrl+J aliniere la stanga-dreapta
Ctri+R aliniere la dreapta
Ctrl+M indentarea la stanga a paragrafelor
Ctri+T indentarea la dreapta a paragrafelor
Ctrl +1 spatiere la 1 rand
Ctrl+2 spatiere la 1,5 randuri
Ctrl+5 spatiere la 2 randuri
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Editorul de texte Word
Formatarea unui document Word

INTRODUCEREA SI ARANJAREA
IN PAGINA
A OBIECTELOR (IMAGINILOR)

- Cu ajutorul barei de desen putem insera in documente atat clipuri din colectia ClipArt cét si alte
imagini.
- Imaginile introduse pot fi aranjate in interiorul paginilor, dupa preferintele utilizatorului.
- Fisierele imagine pot fi de tip GIF, JPG sau BMP.
- Aceste figiere sunt cunoscute si sub numele de “obiecte”; ele pot fi miscate in interiorul paginii
(trase cu mouse-ul = Drag&drop) cat si redimensionate ( tragem de colturi tot cu mouse).
Exercitiul nr.1
Sa se deschida fisierul Digital.doc.n el se va introduce textul de mai jos, neformatat(brut):
Intel are 0 noud identitate
Intel Corporation si-a lansat o noud identitate de brand. Sistemul include noi logo-uri

pentru tehnologia Intel Viiv si pentru tehnologia mobila Intel Centrino, precum si logo-uri

regandite pentru procesoarele, chipseturile, placile de baza si celelalte tehnologii Intel,

Logo-ul fiecarui produs incorporeazd si noul logo Intel. Tn anul care a trecut, Intel s-a

reorganizat in jurul modelului de platformd, iar acum se concentreaza asupra a patru

segmente de piaza esentiale: dispozitivele mobile, locuinza digitala, compania mare i

sanatatea. Compania a mai anunzat ca la inceputul anului 2007 va lansa pe piatd 0 noud

platformd pentru locuinza digitala.

a) se va formata textul, /indnd cont de urmatoarele specificayii:

- literele titlului vor fi Times New Roman, vor avea marimea de 16, ingrosate si
subliniate; literele corpului vor avea marimea de 14; dupa fiecare doua fraze scrise, se va

salva conyinutul figierului( ); -
b) se va introduce o imagine in partea stanga a textului.
Rezolvare:

Vom parcurge urmatorii pasi:
a )-deschidem figierul Digital.doc:
- clic-dr > New >Microsoft Word Document
- introducem Digital.doc
- deschid
clic-clic > =

Digital.do

- controlam daca bara de formatare este instalata:

TimesNewRoman»(10 ~ B 7 U E|===i=- =i &E= 0-£-A-

daca nu, o instalam: clic = View - Toolbars = Formatting
- incepem introducerea textului brut; pentru a da diferite atribute textului
(ingrosare, marime etc.) selectam zona, activam butoane, apoi deselectam
zona.
b)- Pregatim introducerea imaginii:
- controlam daca bara de desen este instalata( partea de jos a ecranului):

Draw- [3 AutoShapes- ~ O E 4l & - ZL-A-=E=E B a@ .
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Editorul de texte Word
Formatarea unui document Word
daca nu, o instalam: clic = View = Toolbars = Drawing
- daca vrem sa inseram un clip -- clic > (&
{ clp At - x
Search for —
[LGe ]

Smarch in

-se deschide galleria oo oy
de Cllpuri — CIiC 9 GO 9 Results should be)

[ Al madha flle types  »

ELH’gJ
- alegem clipul preferat -- clic ->
: . i
- deschidem manseta din dreapta > %

apoi --clic = Insert

~

N R ; Format Picture HER
- al"al’l]dm poza In Stanga teXtUlUl Colursand\_inasl Size  Layout |Picture | TextBaxl Wieh |
clic-dreapta pe = poza s
clic-stanga - Format Picture o ’ ’ = ’ 4
CI iC-Stanga 9 Layo Ut 9 Inline withtext  Square Tight Behind ket Infront of bext
Horizontal alignment
et € Center " Right  Other
Lovtet qre o o
_ _ T
- migcam poza din saget si o redimensionam e
(ST - . APl gia:
tragand de colguri > : Lopeat e,

sndelulingy o |
WP & By
sookide, dacaiwgs |
Compania a moi

e pe ploge ¢ xoxd plagfarmed peaow b

Exercitiul nr.2
a) Sa se introduca n textul de mai sus, sub prima imagine, o a doua imagine ( (preluata din

ClipArt). Noua imagine va contine elemente legate de domeniul IT.Apoi imaginea va fi micsorata
(tragdnd de colyuri) si pozitionata in dreapta textului.

b) Sub text se va introduce un peisaj.

c¢) Titlul va fi rescris cu WordArt.
Sarcina de lucru suplimentara

Sa se raspunda la urmatoarele intrebari:

a- Cum se numeste colectia de imagini pusa la dispozitie de Word ?

b- Pe ce bara se afla pictograma acestei colectii ?

C- Pe ce bara se afla butonul B?La ce foloseste acest buton ?

d- Ce efect are butonul 1 ?

e- Ce operatiune trebuie efectuata inainte de activarea butonului B ?

f-  Cum putem afisa bara de desen, daca ea lipseste ?
INTRODUCEREA SI CENTRAREA DATELOR
IN TABELE
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Editorul de texte Word
Formatarea unui document Word

- Pentru realizarea tabelelor mai complicate se poate utiliza atat editorul automat de tabele cit si
“creionul” sau “guma” puse la dispozitie de Microsoft Word.
- Optiunea Table = Draw Table pune la dispozitia utilizatorilor un set de instrumente de desen:
creion, gumd, buton de centrare €lc.
Exercitiul nr.1
a) Deschideti documentul Evidentd_operativa.doc; scriefi titlul utilizand \WordArt:
Situatia vanzarilor trimestriale
pe 2006
b) Sub titlu, desenati tabelul:
Vanzari anuale

Grupa de Sem | Sem Il Total anual
produse Trim | Trim | Trim | Trim
I 1 1] AV
Imbriacaminte | 4547 | 4282 | 3821 | 3954
Mercerie 2514 | 2653 | 2458 | 2541

Electrocasnice | 6524 | 6648 | 6324 | 6458
Alimentare 3850 | 3945 | 4025 | 3957
Total:
C) Calculati totalurile pe trimestre si anuale, utilizand formule.
d) Centrati textile in cadrul tabelului.
Rezolvare:
a)-deschidem fisierul Evidentd_operativa.doc :
- clic-dr New > Microsoft Word Document

- introducem ;
numele >

- clic-clic
deschidem i et o, Wt ctre 1 W
_ ]|
_ -scriem it e
titlul cu WordArt

- scriem titlul = =

ALIRLS

Situatia vanzarilod

b)-Generam tabelul cu 2 coloane i 6 linii:

- clic pe - Table 2 Insert 2> Table

Insert Table

- introducem 2> | rable e

Number of golumns: |3

nr. linii si coloane

Number of rows 6 =
-apoi OK
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Editorul de texte Word
Formatarea unui document Word

- inaltam 2>
prima coloana | | :
( Enter-Enter)
- activam -  Table >Draw T; j >
creionul :

- trasam o linie |

- trasam cu creionul | ]
Linii verticale - | - ‘ ‘

- incepem sa introducem datele in tabel
c)- Calculam totalurile pe trimestre (verticala)
- pozitionez sub

coloana Trim |

- clic pe - Table 2 Formula...

. Formula E|
- introducem formula [, ...

=SUM (ABOWE) =SLIM{ABOWED

- ap0| OK Formula E|

Formula:
- pentru calculul =SUMILEFT)

adunarilor pe orizontala
d)- Centram textele (si cifrele):

- selectam tabelul ntregul tabel

(clic pe cruciulita din stanga-sus)
- clic pe - Table > Draw Table
- apare bali 4 4| 2| | =~

- activez butonul = =
pentru centrare

- aleg butonul

Exercitiul nr.2
a) In fisierul Evidenta_vanzari.doc scrieti titlul:

Situatia vanzarilor anuale

b) Sub titlu, desenati tabelul:

Vanzari anuale

Modelul Sem | Sem Il

Trim | Trim | Tot. | Trim | Trim | Tot.

Total
anual
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Editorul de texte Word
Formatarea unui document Word

I Il sem. Il IV | sem.
Citroen C3 32 28 35 33
Peugeot 206 38 35 27 33
Opel Corsa 36 31 34 37
Total:

Sarcina de lucru suplimentara
Sa se raspunda la urmatoarele intrebari:
a- Ce optiune activam pentru a efectua un total intr-un tabel ?
b- Se pot efectua i inmultiri ? Daca da, cu ce functie ?
d- Ce facilitati ofera “creionul” in desenarea tabelelor ?
e- Ce putem sterge cu “guma’ ?
f- Ce optiune activeaza bara ce contine creionul (Tables and Borders) ?
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